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Introduction

by Jes-Soft

Baseball Playbook is a tool to help coaches define, draw and
share baseball plays and drills.

Baseball Playbook has the following features:

An easy to use design tool to sketch baseball plays and
drills.

An animation screen to help you follow the flow of plays.

Storing of plays in a database ordered in categories you
define.

A text editor to describe your plays and drills.

Export and import functions to exchange plays with other
users of this program.

Printing of graphics in high quality.

Creation of plan lists to prepare your practice.
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The Main Screen

The view tab

s ol
View | Sketeh  Text Plan 7}
Wicth; se— Drill i 10 min  Players: 0 .
C - o
Color: Rating: Balls 0
Sketch pen | DrllPloyinio | Plan |

Double Steal Defenses
(These plays are designed with my sor's little league
rules in mind. They may need to be adjusted according
to your own league’s rules.)

> - 1st & 3rd defense
»-Bunt defense
»-Bunting

» Defense
»Defense bunt

These plays are designed for when there are less than
two outs and the infield is drawn in. When there are two
outs. the infield should always play back.

Shortstop Cut-Off
« \When the runner on 1B breaks towards 2B, the
second baseman breaks towards 28 also.
« The shortstop steps forward to receive the throw from
the catcher.
* The third baseman must cover 3B for possible throws
from the shortstop or catcher.

When the view tab is selected the sketch and the text of the current drill is visible.

At the top of the window there are, quick options to open, save or creating a new play.

The ribbon bar has the following buttons and information blocks:
Clipboard

Copy the text and place the text on the clipboard.

hﬁ!-l Copy the sketch and place the sketch on the clipboard. Short cut CTRL+I or Shift+CTRL+I for
a double sized sketch. With the anti-alias option on the export tab options page anti-alias can be set
on or off.

Sketch pen
When an animation is paused you can sketch on the image to emphasize a point. The width and color

of the sketch pen can be set here. The sketch can be cleared by clicking with the left mouse button
outside the play.

To delete a sketch you made, press the eraser button.

Drill/Play info
Information about the play, how many players and pucks are needed, how long should the drill take

and the rating of the drill/play.

Plan

l- 3 Add the selected play or category to the plan. Short cut CTRL+L

Register
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i
il If the program isn't registered the unlock button is visible, to open the activation window.

At the left side the available plays and drills are shown.

There are 5 different play types available (drills, plays, formations, templates and other), which can be
selected by clicking on the buttons at the bottom. the header will show the selected play type.

In the play type you can then select the category followed by the play or drill of your choice.

By right clicking on a play you can copy, delete, rename or give it one or more tags.
By right clicking on a category (one level above play) you can copy, delete or rename a complete
category

When tags are available the tag filter is visible at the top is visible.

At the bottom you can use the Play, Pause, Stop, Previous and Next button to navigate through the
play.

When more than one sequence for the current play is available the program will calculate the
movement of players and pucks to their new position.

Checking the sketch box will animate the play with sketches, the play will pause whenever a new
sequence starts.

If the Loop box is checked the play will run continuously until Pause, Stop or Cancel is pressed.

The best results for an animation are obtained by using numbered players and not to many coaches
and pucks.

Also keep in mind that the program only calculates straight-line movement.

Note that in high resolution you will need a fast computer to achieve good results with full screen color
animation.

1.1.1 Copy play

From : To: Plays in to category
Type Wheel bunt coverage
Play ’F‘Iay ,l Wheel bunt coverage - 3b throw
Wheel bunt coverage - p throw I

Category Wheel bunt coverage - pickoff
Defense Defense bunt -
Play name
Bunt defense 2 Bunt defense 2 I
Progress
| |

o OK ‘3 {Zan{:el‘ ‘ &) Help ‘

To copy a play right click on the play in the list on the left and choose copy.
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To copy a play either the type, category or the play name must be changed.
The type can be updated by selecting another type from the list box.
The category can be updated by selecting another category from the drop down list, or a new category
can be added by over typing the current category.
A new play name can be typed in the play name box, as this must be a unique name a list of all play
names currently in use is shown.
1.1.2 Copy category
From : To: Plays in to category
Type Base bunt defense -
Play ’F‘Iay ,l Black 3-3-6-4 defense B
Bunt defense 1 I
Category Bunt defense 2
Bunt defense Defense » |Defense-1st-3rd shortstop con
Defense-1st-3rd shortstop coy £
Definite double If gap
Definite double f gap I
Progress Pick off at 2nd
Pick-off after bb i
! I |Pop fly ball between home an I
Single cf {throw home)
‘x {Zan{:el‘ ‘ & Help ‘ Single If {throw home)

1.1.3

1.14

To copy a category right click on the category in the list on the left and choose copy.
To copy a category either the type or category must be changed.
The type can be updated by selecting another type from the list box.

The category can be updated by selecting another category from the drop down list, or a new category
can be added by over typing the current category.

Delete play

To delete a play right click on the play in the list on the left and choose delete.
When deleting a play the visible play will be removed from the current playbook database. No restore
is possible.

Delete category

To delete a category right click on the play in the list on the left and choose delete.

When deleting a play the visible play will be removed from the current playbook database. No restore
is possible.
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115

1.1.6

Rename play
Rename play

From : To: Plays in to category

Type Bunt coverage special
Play Play | |Early break #1

Category I
Bunting Bunt defense -

Play name
1st-3rd fake bunt steal 1st-3rd fake bunt steal |

Progress

| | |
o OK # Cancel| | ¥ Help

To rename a play right click on the play in the list on the left and choose rename.

To rename a play either the type, category or the play name must be changed.

The type can be updated by selecting another type from the list box.

The category can be updated by selecting another category from the drop down list, or a new category
can be added by over typing the current category.

A new play name can be typed in the play name box, as this must be a unique name a list of all play
names currently in use is shown.

Renaming a play can also be achieved by dragging and dropping.

Rename category

Rename categol

From : To: Plays in to category

Type Wheel bunt coverage

Play ’F*Iayr | |Wheel bunt coverage - 3b throw
Wheel bunt coverage - p throw

Category Wheel bunt coverage - pickoff

Bunt defense Defense bunt -

Progress I

| | |

o OK # Cancel| | ¥ Help
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1.1.7

To rename a category right click on the category in the list on the left and choose rename.

To rename a category either the type or category must be changed.

The type can be updated by selecting another type from the list box.

The category can be updated by selecting another category from the drop down list, or a new category

can be added by over typing the current category.

Renaming a category can also be achieved by dragging and dropping.

Tags

Add or remove tags

Available tags:

Taags for: Post up inside

Condtioning
Defense
Excellent
Offense
Season 2010
Season 2011
Season 2012
Transition

« OK

>
<

Offense zone
Season 2008
Season 2009

‘ﬁﬂanc&l‘ ‘ &4 Help

if there are a lot of tags, you can assign them in the add or remove tags dialog.

Multiple selection is possible.
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1.1.8

Register

Baseball Playbook 011

Reaqister key:

Information about registering this product can be found at:
http:/fwwnw.jes-soft.com/baseball/register.html

« OK |ﬁ Ean{:el| ‘ & Help ‘

If the playbook program is not registered, you can input your activation key here.

After a 30-day trial period some functions of the playbook program will only be available for registered
users.

The registered version of Baseball Playbook has the following extras:
Creation and export of plan lists.

Export to animation in flash format.

Snap to grid when drawing a sketch.

Export of a drill in PDF file format.

Sending a play with e-mail.

Changing of the line color and line thickness.

Undo, redo on the edit drawing tab.

Add text to a play sketch.

Use of different colors with polygons and ellipses.

Export of play sketches in PNG file format.

Curved movement lines.

Dragging of line points.

Auto placement of players when adding a new last sequence.
And more....

More information on registering this product can be found at:
www.jes-soft.com
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1.2

The sketch tab

Sketch

¥ Snap to grid Curved lines < Selectal . . Drillime: 10 min  Playerss 6 -
 Previous lines Width: h . Flip X E
Color: NN i g s &

+ Previous positions <> Mirror

Pyeroption: | fid | oting | [ ren_|

Offense

- 15t & 3rd defense
1> Bunt defense
> -Bunting
4-Defense

- Base bunt defenss

- Black 3-3-6-4 defense

-~ Bunt defense 1

- Bunt defense 2

- Defense-1st-3rd shortstop cover

- Defense-1st-3rd shortstop cover 2
-~ Definite double If gap
- Definite double rf gap
-~ Pick off at 2nd
Pick-off after bb
Pop fy ball between home and first base i
Single cf (throw home)
Single IF (throw home)
Single rcf (throw home)
Walking double
wid pitch
1+ -Defense bunt
4 -Double steal
Double steal defenses

Drills.
-
Animation only
Formations __-H- Add sketch
renpstes
(@ vovesicthdom |
Other = Delete sketch )

With the sketch tab selected a sketch of the current drill can be edited.
At the top of the window there are, quick options to open, save or creating a new play and to undo/redo
your last action.

The ribbon bar has the following buttons and information blocks:

Draw options

To align players and lines check the snap function and select the size of an invisible snap grid.

If the previous position checkbox is checked the players of the previous sequence are drawn in light
gray.

With the previous lines checkbox you can show or hide the lines of a previous sequence, if there are
no lines in the previous sequence the sequences before that will be checked for lines.

Line options
To make curved lines check the curve checkbox.

You can also set the current drawing pen color and width.
Clicking the expand button will open the default line settings dialog.

Player options
Quickly select the symbols for offense and defense.

Change the default player settings by clicking the expand button.

Field
]
l;‘ Change the field colors by pressing the paint button on the field block.
Editing
Select all players and lines at once.
Flip the sketch.

Mirror the sketch.

Formations

ﬂ When more than 1 player is selected you can save the selected players as a formation.
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*5 The add formation button, will show a number of predefined formations which can be used in
the current sketch.

Drill/Play info

Information about the play, how many players and pucks are needed, how long should the drill take
and the rating of the drill/play.

Change the play information by pressing the expand button.

Plan

! hJ Add the selected play or category to the plan.

At the left side the available plays and drills are shown.

There are 5 different play types available (drills, plays, formations, templates and other), which can be
selected by clicking on the buttons at the bottom. the header will show the selected play type.

In the play type you can then select the category followed by the play or drill of your choice.

By right clicking on a play you can copy, delete, rename or give it one or more tags.

When tags are available the tag filter is visible at the top is visible.

On the right side you can select the sketch to work on.

If the Animation only checkbox is checked the current sequence will not be printed.

Add a sketch below the current sketch by pressing Add sketch, The maximum number of sketches
per play is 75.

Move a sketch up or down.

And delete the selected sketch.

The players, pucks and coaches can be selected and dragged and dropped on the field, with the main
mouse button.

The movement of players and pucks can be drawn with the 5 different arrows. The ellipse and polygon
can be used to give a part of the field a different color. The text button can be used to add text to a
sketch.

See the symbols for an explanation of the different graphics.

The field can be changed by selecting a new one and pressing the Ok button, sometimes the field
button must be pressed to show this option.
Choose apply to whole play to update all sketches in a play in one go.

To select multiple players and lines, lines hold down the CTRL button while clicking on the
players/lines.

You can also select an area of the field by holding down the shift key and using the main mouse button
to resize a selection rectangle.

Finally all players/lines can be selected by choosing Edit - Select All or by pressing CTRL-A.

The Delete button will delete selected players or movement lines.

When a player is selected with the other mouse button, a player edit window is shown and depending
on the player the color, text or rotation can be altered.
The same option can be used for lines, ellipses, polygons and text.
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1.2.1

Default line settings

Edit default line settings

' Arrow Curved

HEEE
EEET
EEEE

Width:

- ‘ tore Colors

& OK ‘ﬁ EancelH Default H Reset H & Help ‘

In the default line settings window the default color of the lines can be altered. This is achieved by
selecting a color from the quick color select area or by pressing the more colors button to open a color
dialog.

The arrow at the end of a line can be removed or made visible by selecting the arrow checkbox.

If you want a curved line check the curved box.

Finally the thickness of a line can be changed from 1 to 5.

Pressing the OK button will store the new color and appearance and bring you back to the main
window.

The Cancel button will reset the color and appearance to its previous values and bring you back to the
main window.

The Default button will load the default values for a line.

The Reset button will reset the color and appearance of a line to their previous values.
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1.2.2

Default player settings

Edit default player settings

Offense | Defense

EEEEE |

. Iilll_l

ZoomE 112 = Mare Colors... ‘
Only number Mumber color
V' Fadng arrow - Mare Colors... ‘

‘ <+ OK Hﬁﬂanc&l‘ Default ‘ Reset ‘ ﬁﬂelp‘

In the default player settings window, the symbol for offense and defense can be changed by pressing
the arrow buttons left of the player.

The players can be resized by changing the zoom level.

It is possible to just show the number without a border outline by checking the only number button, if
available.

For some of the symbols that cannot rotate a facing arrow is available to show where the player is
looking at.

The default color for offensive and defensive players can be altered. This is achieved by selecting a
color from the quick color select area or by pressing the more colors button to open a color dialog.

Finally the number color can be changed.
Availability of the options varies for the different player symbols.

Pressing the OK button will store the new color, label and rotation of the player and bring you back to
the main window.

The Cancel button will reset the color, label and rotation of the player to its previous values and bring
you back to the main window.

The Default button will load the default values for the colors, label and rotation of the player.

The Reset button will reset the color, label and rotation of the player to their previous values.
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1.2.3

1.2.4

1.25

Field color

@ Apply to whole play BawW field

() Apply to sketch B&W field and players

Ot field

‘ Mare Calors. . ‘

|3Eanc&l“ Default H Reset H &) Help ‘

Select if you want the changes you made to be applied to the whole play or only the current sequence.

If you want a black & white field or a black & white field with black & white players then check the
corresponding option.

You can alter the colors by first selecting the area on the field and then selecting a color from the quick
color select area or by pressing the more colors button to open a color dialog.

Pressing the OK button will store the new colors and bring you back to the main window.
The Cancel button will reset the colors to their previous values and bring you back to the main window.
The Default button will load the default values for the field colors.

The Reset button will reset the colors to their previous values.

Flip sketch

When on the drawing tab you can flip an image.
You can choose to flip one sequence or the whole play on the sketch of the options menu.

Mirror sketch

When on the drawing tab you can mirror an image.

You can choose to mirror one sequence or the whole play on the sketch tab of the options menu.



The Main Screen 19

1.2.6 Save selection as formation

Category: Selection:
Field
Mew formation name:

One, two and three

Existing formations:

Maone

One

One and three
One and two
Three

Two

Two and three

|*{Zam:el|| &) Help |

If 2 or more players are selected on the edit drawing tab the Save Selection As Formation option
becomes available in the Edit menu.

A preview of the formation is given and a new category and formation name can be selected.

The category can be updated by selecting another category from the drop down list, or a new category
can be added by over typing the current category.

A new formation name can be typed in the new formation name box, as this must be a unique name a
list of all formation names currently in use is shown

After saving the formation by pressing the Ok button, the formation becomes available in the Add
formation list.
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1.2.7 Add formation

i fomaton o play
Category: Prewiew: 1
| Field -

Formations:

Maone

One

One and three
One, two and three
Three

Two

Two and three

& OK ¥ Cancel| | & Help

The add formation window shows a number of predefined formations which can be used in the current
sketch.

To use a formation change the Category and select a formation from the list. Press the Ok button and
the formation will be added (selected) to the current sequence.

As the formation will be selected, you can move the formation with the arrow keys or by dragging a
selected player to its new position.

New formations can be created with the Save Selection As Formation function in the Edit menu.
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1.2.8

Play info

Edit drill/play info

Dirill time: Sub category 1:

| 10 min | v| |5hn|::ting | v|
Mr of players: Sub category 2:

2 -] [Mone -]
Mr of balls: Sub category 3:

1 -] [Mone -]
Rating: Level:

010203@405 1020304@5

o OK ‘ - {Zan{:el‘

& Help

To view, add or update additional play information go to the File menu and choose Play Info...

Information that can be entered include:

The drill time

The number of pucks and players required for a drill.
Additional categories if a drill is multi functional (hitting, catching and throwing).
The level of the drill 1 novice, 5 expert.

And your own rating of the play.

21
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1.2.9 Edit player
Edit player

N | |
ENEEEER
EEEEEN
ENEEEER
ENEEEER
ENEEEE

MHurnber

2 Only number - ‘ More Colors... ‘
Zoom & Mumber color

1an = - More Colors... ‘
Roatation

272 = Facding arrow

& OK ‘ﬁﬂanc&l” Default H Reset H &4 Help ‘

In the edit player window the color of each individual player can be altered. This is achieved by
selecting a color from the quick color select area or by pressing the more colors button to open a color
dialog.

If it is possible to change the number/name of a player a label edit box is visible to alter the number of
a player. It is also possible to just show the number without a border outline by checking the only text
button, if available.

The players can be resized by changing the zoom level.

For some of the symbols that cannot rotate a facing arrow is available to show where the player is
looking at.

For wheelchairs it is also possible to rotate, by clicking on the rotation circle or by adjusting the value in
the rotation edit box.

Finally the number color can be changed.
Availability of the options varies for the different player symbols.

Pressing the OK button will store the new color, label and rotation of the player and bring you back to
the main window.

The Cancel button will reset the color, label and rotation of the player to its previous values and bring
you back to the main window.

The Default button will load the default values for the colors, label and rotation of the player.

The Reset button will reset the color, label and rotation of the player to their previous values.
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1.2.10 Edit line

Edit line

e |
ENEEEN
ENEEEER
ENEEEER
ENEEEN
EEEEEE

- ‘ tare Colorz ‘

‘ & OK Hﬁﬂanc&l” Default H Reset H ﬁﬂelp‘

o Arrow Curved

Width:

The type of a line can be changed, from shot to pass for example, by pressing the up and down
buttons next to the line.

In the edit line window the color of each line player can be altered. This is achieved by selecting a color
from the quick color select area or by pressing the more colors button to open a color dialog.

The arrow at the end of a line can be removed or made visible by selecting the arrow checkbox.
If you want a curved line check the curved box.
Finally the thickness of a line can be changed from 1 to 5.

Pressing the OK button will store the new color and appearance and bring you back to the main
window.

The Cancel button will reset the color and appearance to its previous values and bring you back to the
main window.

The Default button will load the default values for a line, but will not change the line type.

The Reset button will reset the color and appearance of a line to their previous values.
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1.2.11 Edit ellipse

Edit ellipse

¥ Border

Thickness
‘ More Colors ‘ ©1@®203040 5

3 Cancel|| Default

When the solid checkbox is checked, the ellipse will have a solid color, which you can change by
selecting a color from the color box or by pressing the more colors button below the color box.

If the solid box isn't checked the ellipse will be transparent, the field colors will shine through the
ellipse, the colors can be altered and removed from an ellipse by either selecting or altering the red,
green and blue color values.

The lock option will change the three colors together.

Pressing the clear button will create an ellipse with 100% transparency, or in other words only the
border will be visible, deselecting the border will result in an invisible ellipse.

By selecting the border checkbox a border will be drawn, thickness and color can changed with the
available options.

Pressing the OK button will store the new color and bring you back to the main window.
The Cancel button will reset the color to its previous value and bring you back to the main window.
The Default button will load the default values for an ellipse.

The Reset button will reset the color etc... of an ellipse to its previous value.
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1.2.12 Edit polygon

7 Salid [ Clear ]

| [ |
I HAEEn
EEEEEE
EEEEEE
EEEEEE
EEEEEE

- ‘ kore Colors ‘
¥ Border
Thickness
‘ More Colors ‘ ©102@30 405

[ & OK ”3 EanuelH Default H Reset H ﬁﬂelp|

When the solid checkbox is checked, the polygon will have a solid color, which you can change by
selecting a color from the color box or by pressing the more colors button below the color box.

If the solid box isn't checked the polygon will be transparent, can be altered and removed from a
polygon by either selecting or altering the red, green and blue color values.
The lock option will change the three colors together.

Pressing the clear button will create a polygon with 100% transparency, or in other words only the
border will be visible, unselecting the border will result in an invisible polygon.

By selecting the border checkbox a border will be drawn, thickness and color can changed with the
available options.

Pressing the OK button will store the new color and bring you back to the main window.
The Cancel button will reset the color to its previous value and bring you back to the main window.
The Default button will load the default values for a polygon.

The Reset button will reset the color etc... of a polygon to its previous value.
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1.2.13 Edit text

Edit text
Font: ¥ Background
Arial - I_ I_ I_ .
Size: Style: . . . .
v U
e T 1117
- | More Colors... | . . . .
Sampl
o AaBbYyZz . . . .
¥ Border . . . .
- | More Colors. . | I | More Colors.... |
Hello,
How are you?
& OK ” ® Ean{:eIH Default H Reset H & Help ‘

In the edit text window, text to be added to a sketch can be typed and altered.
The font can be adjusted, by selecting the font name, size and style.
Additional font colors are available by pressing the More Colors... button.

By checking the border checkbox, the text will be drawn in a box. The color of the border can be
changed by pressing the More Colors... button.

To give the text a background color check the background box. The color of the background can be
changed by selecting a different color from the color box or by pressing the More Colors... button.

The sample area will show a preview of the selected font.

Pressing the OK button will store the new text and bring you back to the main window.
The Cancel button will bring you back to the main window, no changes will be made.
The Default button will load the default values for a sketch text.

The Reset button will reset the values for a sketch text its previous values.
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1.3

The text tab
. 3 Far
B View et Text | Plan =
A A 6 - M- o Selectal  Drlitime 10 min  Players 0 ~
D IN=EE=E=E o Ratng: COO0 Bale 0| K3
| Fomat __ J Editing | | _Plan_|
Bunt situation!

> - 1st & 3rd defense
> -Bunt defense
> - Bunting
> -Defense
4 -Defense bunt
{ L.\Wheel bunt coverage
 ..\heel bunt coverage - 3b throw
¢ ..\heel bunt coverage - p throw
i .\heel bunt coverage - pickoff
4 -Double steal
i - Dotble steal defenses
> -Example
> - Fielding
4 -Game situation
st and 2nd rundown

« |deally the hitter will try to lay the bunt down the 3rd base side to force the 3rd baseman off the bag, freeing up the backside for the runner on second to
advance.

« The shortstop must keep the runner at second close befare the play even starts. SS must be chatting in the runner's ear to let him know he is there.

When the text tab is selected the text can be edit, also the associated sketch is visible.

Animation only

P Add sketch

Move sketch up
& Move sketch down

At the top of the window there are, quick options to open, save or creating a new play and to undo/redo

your last action.

The ribbon bar has the following buttons and information blocks:

Clipboard

D Paste the text from the clipboard.

A Cut the text and place the text on the clipboard.

Copy the text and place the text on the clipboard.

Format

Change the text style, size and color.
Insert special symbols.
Use the text edit buttons to format the text.

Editing

Select all the text at once.

Drill/Play info

Information about the play, how many players and pucks are needed, how long should the drill take
and the rating of the drill/play.
Change the play information by pressing the expand button.

Plan

=

Add the selected play or category to the plan.

At the left side the available plays and drills are shown.
There are 5 different play types available (drills, plays, formations, templates and other), which can be
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selected by clicking on the buttons at the bottom. the header will show the selected play type.
In the play type you can then select the category followed by the play or drill of your choice.

By right clicking on a play you can copy, delete, rename or give it one or more tags.

When tags are available the tag filter is visible at the top is visible.

On the right side you can select the sketch to work on.

If the Animation only checkbox is checked the current sequence will not be printed.

Add a sketch below the current sketch by pressing Add sketch, The maximum number of sketches
per play is 75.

Move a sketch up or down.

And delete the selected sketch.

The plan tab

N View Sketeh Text |Plan | .7
Team; Jes baseball Dater 1/972014 [
Location: Park next to office From: 1330 % T 15:00 [
| Padiceinfo |
4-Bunting Double steal, Double steal defenses.
' Bunting carousel Start tme: g Double Steal Defenses
" Combined ot om0 [7] {These plays are designed with my sor's littie league rules in mind. They may need to be adjusted according to your own league's rules.)
> -Fielding These pl designed for when th less than twa outs and the infield is drann n. When th w0 outs, the infield should always play back.
. 0 [~] plays are designed for when there are less than two outs and the infield is drawn in. Wihen there are two outs, the infield should always play back.
» - Infield/baserunning Players:
» - Outfield . 1 Shrtstop Cut-Off
+ Pre-game Bals: L [ When the runner an 18 breaks towards 28, the second baseman breaks towards 28 also
! The shortstop steps forward to receive the throw from the catcher.
> - Running . Rating: » ® The third baseman must cover 38 for possible throws from the shortstop or catcher. B
4 -Station worl
Bunt, banana turns &run down
i Bunting practice, base bunt def
» Thrawing
> - Warming up
Station wos banana turns _run down
Start tme:  |13:50 S| PRACTICE mﬂ;m :
STATION WORK
Drilgme: [ Smn [+
Station One: Banana Turns B
Players: o [+] 3 pitchers, 1 first baseman _1 coach to rol balls.
. ++
S = [ Station One Desaription:
) Coach rols the ballfar to first baseman's right.
Rating: ® First baseman moves to his right to field ball.
Pitcher covers 1t base using a banana turn.
Station Two: Run Down Drill
4 position players 1 runner,
Drills R
Station work, Bunting practice, base bunt def
Start time: Practice Number One
Bae BN 5unting Practice Base Bunt Defense
Drill tme:
= Payers: . Smt?inrorve‘ “Easi Bunt DEfE;v‘sE FNuhndv on Base) il
4 Move play/dril up
e
& Move play/drill down
Other == Delete play/drill

When the plan tab is selected, you can create, edit or export a plan list.

At the top of the window there are, quick options to open, save or creating a new plan.

The ribbon bar has the following buttons and information blocks:
Practice info
Fill in the team, place, date and time for which you are creating a plan.

At the left side the available plays and drills are shown.

Add plays/drills or complete categories by dragging them from the list to the plan.

There are 5 different play types available (drills, plays, formations, templates and other), which can be
selected by clicking on the buttons at the bottom. the header will show the selected play type.

In the play type you can then select the category followed by the play or drill of your choice.

By right clicking on a play you can copy, delete, rename or give it one or more tags.
When tags are available the tag filter is visible at the top is visible.
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You can change the play info of each drill in the plan area, by changing the drill time, number of
players/pucks and the rating of a play.

Move a play/drill up or down with the buttons at the bottom.
Finally you can remove a play/drill from the plan list using the delete button.
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2 File menu

New

Create a new play or drill

New play
Create a new play ordrill.
l. Open
’ New play from template
Create a new play or drill using one ofthe predefined templates.
H Save ﬁ N
New plan
= Create a new practice plan
e, Export ¥ E
# Print b

. Send using E-mail  »

a Backup ¥
L]

£} Options 3 ClosePlaybook

From the file menu you can:

Create a new play, a new play for a template or a new plan.

Open plays and drills or plan lists.

Save plays and drills or plan lists.

Export plays and drills or plan lists to different formats like HTML and PDF.
Print plays and drills or plan lists.

Send plays in drills via e-mail.

Backup part of or the complete playbook database.

At the bottom there are two buttons, Options to set all your preferences and Close playbook to end the
playbook program.
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Adding a new play

Type Field layout
| il

Category

Infield fbaserunning

Mew play name

Infield chedk

Existing plays

3 station live infield
4 corner live running

HEER)

[ & OK ”*Eam:elH & Help

To add a play go to the File menu and choose New play.
When in the New play window:

Choose a category from the dropdown list or add a category by typing over the current category with a
new category.

After choosing or adding a category fill in a new play name, as this must be a unique name a list of all
play names currently in use is shown.

Selecting one of the available fields and pressing the Ok button brings you back to the main window
with the new play selected.

Additional plays can be found at the Baseball Playbook Homepage.
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2.2

2.3

New play from template

Create a new play from te

From : To: Plays in to category

Type Double steal defenses

Template Play -

Category !
Setup Double steal -

Play name

Field positions 1 Defense double steal 1 I
Progress

o OK ‘3 {Zan{:el‘ ‘ &) Help ‘

When the template play type is selected and you have selected a play you can add a play from a
template by going to the File menu and choose New play from template.

Choose a new play type.

A category from the drop down list or add a category by typing over the current category with a new
category.

After choosing or adding a category fill in a new play name, as this must be a unique name a list of all
play names currently in use is shown.

Pressing the Ok button brings you back to the main window with the new play selected.

New plan

By selecting the File - New option when on the plan list tab you can start a new plan list.

If your previous plan list has been altered then you will be asked if you want to save the changes.
Otherwise the plan list is cleared directly.

Open plays

To open a play go to the File menu and choose Open...

From the Open menu *.EBP and *.Bak files can be opened and loaded into the Baseball Playbook
Database.

If the play name of the new play already exists in the database the New Play name window is shown.
This allows you to :

1.Alter the play name.

2.Skip/Cancel the loading of the play.

3.Replace the play in the database with the new play.

Additional plays can be found at the Baseball Playbook Homepage.
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If the Edit text tab is selected it is also possible to load text files (*.TXT and *.RTF). The contents of
text files is appended to the text in the text window.
2.3.1 New play name
Please enter a new play name: - ‘
Message Existing Plays
The play: "Defenze-1st-3rd shortstop cover' of bype Base bunt defense i
"Play" in categony: "Defenze’ 1z alrieady part of your Black 3-3-64 defense
playbiook. Bunt defense 1
Flease enter a new name or cancel the import of this | Bunt defense 2
play. Defense-1st-3rd shortstop «
Defense-1st-3rd shortstop (=
Definite double If gap
Definite double f gap
| New Play Name Pick off at 2nd
Defense-1st-2rd shortstop cover 2| Pick-off after bb
FPop fly ball between home
Single cf (throw home)
‘ « OK ‘ Replace ‘ Single If (throw home) ~ ~
‘ # Cancel ‘ Skip ‘ | & Help
In the New play name window a play can be given a new unique name so it can be loaded in the
database.
If a new play name is typed the play can be stored in the database by pressing the OK button.
When a backup file is opened you can choose to skip the current play and continue with the next play
in the file by pressing the Skip button.
To avoid pressing the Skip button all the time you can press the Skip All button, this will skip all play
names already in your database, but load all the other plays.
It is also possible to replace the plays in the database by the plays being loaded by pressing the
Replace button.
As with the Skip All button there is also a Replace All button to avoid pressing the Replace button all
the time.
Pressing the Cancel button will end the loading of the file/play and all other plays in the file.
2.4  Open plan list

To open a plan list select the plan list tab, go to the File menu and choose Open...

From the Open menu you can select *.LST and *.CLT files. Where the *.LST files only contain a list of
the plays and the *.CLT files contain a list of the plays and the complete description of the plays and
drills in the list.

When Opening a *.LST file:
A play might not be in your database, when this is the case you will be asked if you want to continue
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loading the plan list.
If your answer is No the plan list will not be loaded into the play and drills database.

When opening a *.CLT file, or complete list file:

If the play name of the new play already exists in the database the Skip replace window is shown. This
allows you to :

1.Skip/Cancel the loading of the play.

2.Replace the play in the database with the new play.

2.4.1 Skip replace play window

Please enter a new play name: - ‘

Message Existing Plays

The play: "Bucket drill” of type "Drill" in categorny: Base rotation

"Fielding" iz already part of your plapbook, Bat drill

Pleaze enter a new name or cancel the impart of thiz | Bucket drill

play. Diamaond drill
Double {cover) play drill
Infield cut
Pepper

New Play Name Underhand toss drill

Bucket drill

‘ o OK ‘ Replace Hﬂepla{:eall

‘ # Cancel ‘ Skip ‘ | Skip all ‘ | & Help

Here you can choose to skip the loading of a play, with the same name as a play in your play
database, and continue with the next play in the file by pressing the Skip button.

To avoid pressing the Skip button all the time you can press the Skip All button, this will skip all play
names already in your database, but load all the other plays.

It is also possible to replace the plays in the database by the plays being loaded by pressing the
Replace button.

As with the Skip All button there is also a Replace All button to avoid pressing the Replace button all
the time.

Pressing the Cancel button will end the loading of the plays in the file, not the plan list.

2.5 Save plays
To save a play go to the File menu and choose Save...
In the save menu plays can be saved in *.EBP files.
The default file name is the play name of the play.

After saving the file can be distributed to other users of the program, for example as an attachment in
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2.7

2.7.1

an e-mail.

Save play list

To save a plan list select the plan list tab, go to the File menu and choose Save...

From the Save menu you can select *.LST and *.CLT files. Where the *.LST files only contain a list of
the plays and the *.CLT files contain a list of the plays and the complete description of the plays and
drills in the list.

The default file name is the title of the plan list.

Export

Export sketch
To export an image in JPG or BMP format go to the File menu and choose Export - Export sketch.

The default file name is the play name of the play with the sequence number attached.
After saving the image it can be loaded in image editors or word processors.

Export play or category
You can also export a complete play or category in formats like HTML and PDF.

Additionally plays can be exported in, HTML with animated gif or HTML with Flash.

Export sketch

[ Export sketch )
Size:
Q |[|Q || ||@
ué ho ﬁo u¢
Sketch file format:
. ke

BEMP IPG PMNG

' Try using anti-alias on exported sketches

o OK # Cancel

In the export sketch dialog you can change the size of the exported image to 1, 2, 3 or 4 times the
original format.

e

After that choose the file format, Bitmap (BMP), JPG or PNG.
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Finally you can choose to use an anti-alias filter on the exported sketches, by checking a check box.

Pressing the Ok button will sent you to the save dialog.

Export to PDF

Prepare PDF

g

Sample Page Layout
_ L
Export:
@ Play () category
¥ Preview
Sequence gettings:
Mo text
Hide playname
Image quality Low
| < OK | ‘ d Setup ‘ ‘%Eanc&l‘

@ Columns

Page settings:
¥ Show header

¥ Show contents page
Playbook

Start each play on a

) Rows

K| <|| =B

PDF _settings:
Indude fonts

! 0N & New paage

MNewspaper layout 35

¥ Open in reader

This option will export the current play in PDF format.

The following options can be set:

If the Show Header checkbox is checked a header is added to the PDF file, containing a logo and the

category.

The logo can be changed on the export tab of the options menu option.
To use unformatted text check the Use plain text checkbox.

Pressing the Ok button will save the play in PDF format. The default file name is the play name of the

selected play.

image quality (not recommended).

PDF files can be opened with the free Adobe Acrobat Reader. If you are experiencing problems

opening PDF files, please download the latest free version of Adobe Acrobat Reader.

To decrease the file size of the PDF file, you can deselect the Include fonts checkbox and lower the
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2.7.3 Exportto HTML

Export HTML - - _‘ -

Export:

i) Play @ Category
Page settings:

¥ One page ¥ Show contents
V' Show header Lse plain text

Try using anti-alias on exported sketches ¥ Open in default browser

.

Page width 77E

-

Progress:

‘ & OK Hﬁﬂanc&l‘

This option will export the current play or category in HTML format.

The following option can be set:

When exporting a category, you can choose to export the category into one html or multiple html files.
If One page is chosen the contents can be hidden be clearing the Show contents checkbox.

If the Show header checkbox is checked a header is added to the HTML file, containing a logo and the
category.

The logo can be changed on the export tab of the options menu option.

To use unformatted text check the Use plain text checkbox.

The page width in pixels can be changed by setting a new value.

Pressing the Ok button will save the play in html format. The default file name is the play name of the
selected play.

After saving the play in HTML format with static images the file can be used to import the play in all
modern word processors.

The file format of the images used with the HTML export can be set in the export tab of the options
menu option. The images part of the play will be saved with the sequence number added to the
filename. Images will be saved in a separate folder with the name of the play.
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Export to HTML with animated GIF

Export to HTML with animated GIF

Animation_zettings: Frame delay 1/100th of a sec.

V' Use transparent color First frame 00 =
@ Loop animation MNormal frame 10 -
) Play 1 — times Sketch frame 300 =
¥ Within himl page Last frame >0 .

Page settings:

¥ Show header Page width 77 .

Ise plain text ¥ Open in default browser

‘ & OK ‘ ‘ﬁﬂanc&l‘ & Help

This option will export the current play in animated GIF.

The following options can be set:

Use transparent color, if checked only the changes in the frames will be saved in the animation file
resulting in a smaller file size.

Loop animation, keep on playing the animation.

Play animation x times, Repeat playing the animation a x number of times.

The time a frame is shown can be set, there are 4 kinds of frames:

The first frame of the animation.

A normal frame, these are intermediate frames created by the application to get from one sequence to
an other and the sequences where the animation only checkbox is checked.

A sketch frame, the sequence where the animation only checkbox is not checked.

And the last frame of the animation.

When the Within html page checkbox is checked the following options are available:

If the Show Header checkbox is checked a header is added to the HTML file, containing a logo and the
category.

The logo can be changed on the export tab of the options menu option.

To use unformatted text check the Use plain text checkbox.

The page width in pixels can be changed by setting a new value.

Pressing the Ok button will save the play in GIF format with a html page if selected. The default file
name is the play name of the selected play.
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2.7.5 Export to HTML with Flash
Export to HTML with Flash
Animation_zettings: Frame delay 1/100th of a sec.
¥ Show buttons First frame 500 =
Color... = 1 N Mormal frame 10 =
| Sketch frame 300 =
Try using anti-alias =
7 Within html page Last frame 200 v
Page zettings:
¥ Show header Page width 77 =
Ise plain text ¥ Open in default browser
‘ < OK ‘ ‘ﬁ Ean{:el‘ & Help
This option will export the current play in flash (file format swf).
The following options can be set:
Show buttons, if checked you can also change the button colors by clicking the Color... button.
The time a frame is shown can be set, there are 4 kinds of frames:
The first frame of the animation.
A normal frame, these are intermediate frames created by the application to get from one sequence to
an other and the sequences where the animation only checkbox is checked.
A sketch frame, the sequence where the animation only checkbox is not checked.
And the last frame of the animation.
When the Within html page checkbox is checked the following options are available:
If the Show Header checkbox is checked a header is added to the HTML file, containing a logo and the
category.
The logo can be changed on the export tab of the options menu option.
To use unformatted text check the Use plain text checkbox.
The page width in pixels can be changed by setting a new value.
Pressing the Ok button will save the play in swf (flash) format with a html page if selected. The default
file name is the play name of the selected play.
2.8  Export plan

When on the plan list tab this option will export the current plan list.
There are 2 export options for a play, depending on what you want choose one of the tabs.
HTML will export the plan list in HTML format with static images.

PDF will export the plan list in PDF format.



File menu 41

The default file name is the title of the plat list.

After saving the plan list in HTML format with static images the file can be used to import the plan list
in all modern word processors.

The file format of the images used with the HTML export can be set in the export tab of the options
menu option. The images part of the play will be saved with the sequence number added to the
filename. Images will be saved in a separate folder with the name of the play.

2.8.1 Export plan to pdf

-
Prepare PDF ™
Sample Page Layout
_ 1 __ I 1
< L || || B
Export: Page settings:
¥ Preview ¥ Show header
List only ¥ Show contents page
Sequence settings:
Mo text ¥ Indude play/drill info
Hide play name header Start each play on a new page
Image quality Low High
PDF settings: @ Columns % MNewspaper layout 3
Indude fonts _ Rows
¥ Open in reader
| « OK ‘ ‘ & Setup ‘ ‘ﬁ Ean{:el‘ i Help
L

This option will export the current plan list in PDF format.

The following options can be set:

Show a contents page.

If the Show Header checkbox is checked a header is added to the PDF file, containing a logo and the
category.

The logo can be changed on the export tab of the options menu option.

Each play in the category can be started on a new page, by checking the checkbox.

By selecting Start each play on a new page, every play will be exported on a new page.
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To use unformatted text check the Use plain text checkbox.

Pressing the Ok button will save the category in PDF format. The default file name is the name of the
selected category.

To decrease the file size of the PDF file, you can deselect the Include fonts checkbox and lower the
image quality (not recommended).

PDF files can be opened with the free Adobe Acrobat Reader.

If you are experiencing problems opening PDF files, please download the latest free version of Adobe
Acrobat Reader.

Export plan to html

Export plan to HTML - —

Page settings:
¥ One page ¥ Show contents

¥ Show header LIse plain text

¥ Indude play/drill info

¥ Try using anti-alias on exported sketches

Y

Page width 77E ¥ Open in default browser

-

Progress:

& OK ‘ﬁ Ean{:el‘ & Help

This option will export the current plan list in HTML format.

The following option can be set:

One page, if checked all the plays in the plan list will be placed in one html file, otherwise the plays will
be placed in separate html files with a separate index.

If the one page option is selected you can choose to add a contents part to the beginning of the file.

If the Show header checkbox is checked a header is added to the HTML file, containing a logo and the
category.

The logo can be changed on the export tab of the options menu option.

To use unformatted text check the Use plain text checkbox.

The page width in pixels can be changed by setting a new value.

Pressing the Ok button will save the play in html format. The default file name is the title of the plan list.

After saving the plan list in HTML format with static images the file can be used to import the html file
in all modern word processors.

The file format of the images used with the HTML export can be set in the export tab of the options
menu option. The images part of the play will be saved with the sequence number added to the
filename. Images will be saved in a separate folder with the name of the category/play.
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Print
Prepare print
Sample Page Layout
[ [ [ L
w = = 3
Print: Page zettings:
q F'|E|'§.l' i | Category ¥ Show header l
¥ Preview ¥ Show contents page
[
Seqguence settings: Playbaok
Mo text Start each play on a new page |
Hide: playname @ Columns Mewspaper layout 2=
Image quality Low High ) Rows
(7] [ o)

To print a play or a category go to the File menu and choose Print.

Print:

Before printing you can select between printing the current play or the current category.

Selecting the preview option will give you a preview of the print, printing from the preview window is the
same as printing with the image quality at its lowest.

Page Settings:

You can choose to print a header with a logo.The logo can be changed on the export tab of the options
menu option.

When you print a category you can add a contents page.

When you want to change the page header text on the content page from Playbook to for example the
name of the team you coach you can alter the Header text.

Each play can be started on a new page when printing a category.

In column mode you can choose to print in newspaper layout.

You can choose to print in rows or a number of columns. To print 1 sketch on a page choose columns,
and set the columns number to 1.

Sequence settings:

Check the No text box if you don't want to print any text.

And check the Hide play name header if you don't want to print those.

Finally you can alter the image quality of the sketch, for a normal printer the second position gives
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good results.
Pressing the Setup button will allow you to change or setup your printer.

Pressing the Ok button will start the printing or show the preview, you can follow the progress with the
progress bar.

You can suppress a sequence from being printed by checking the animation only checkbox on the edit
drawing tab or the edit text tab.

2.9.1 Printer setup

To change the printer setup, press the setup button in the print window.
This window differs per printer and operating system.
Usually you can change the printer, choose the paper layout and switch between color or gray scale

printing.

2.10 Print plan list

© -

Prepare print ™

Sample Page Layout

]
m

fn

I (L

“'|I‘|I"|“|H_|

|| < ==

Print: Page settings:
¥ Preview ¥ Show header
List only ¥ Show contents page

Sequence settings:

Mo text ¥ Indude play/drill info
Hide play name header Start each play on a new page
Image quality Low High
@ Columns Newspaper layout 3
) Rows

(o] (= e [
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2.11

To print a plan list, on the plan list tab, go to the File menu and choose Print.

Print:

Selecting the preview option will give you a preview of the print, printing from the preview window is the
same as printing with the image quality at its lowest.

You can also choose to only print the list including the play info (without the sketches and additional
text), handy for quick references.

Page Settings:

You can choose to print a header with a logo. The logo can be changed on the export tab of the
options menu option.

You can add a contents page.

When you want to change the page header text on the content page from the plan list title to for
example the name of the team you coach you can alter the Header text.

Each category can be started on a new page and within a category each play can be started on a new
page.

In column mode you can choose to print in newspaper layout.

You can choose to print in rows or a number of columns. To print 1 sketch on a page choose columns,
and set the columns number to 1.

Sequence settings:

Check the No text box if you don't want to print any text.

And check the Hide playname header if you don't want to print those.

Finally you can alter the image quality of the sketch, for a normal printer the second position gives
good results.

Pressing the Setup button will allow you to change or setup your printer.

Pressing the Ok button will start the printing or show the preview, you can follow the progress with the
progress bar.

You can suppress a sequence from being printed by checking the animation only checkbox on the edit
drawing tab or the edit text tab.

Send play

In default mode the program will try to use your standard e-mail client like Outlook Express or
Thunderbird.

You can choose between an EBP or PDF file attachment.

EBP is playbooks own file format; the receiver needs a playbook (same or higher version number)
program to be able to view this. With the EBP format the play can be animated and edited by the
receiver.

PDF files can be read with the free Adobe Acrobat Reader.

When you enter your mail preferences then the internal e-mail client of the playbook program will be
used and the following options will be available.

You can choose between an EBP or PDF file attachment or HTML with inline images.

EBP is playbooks own file format; the receiver needs a playbook (same or higher version number)
program to be able to view this. With the EBP format the play can be animated and edited by the
receiver.

PDF files can be read with the free Adobe Acrobat Reader.
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HTML files with inline images can be viewed with most e-mail clients like outlook express, most web
mail readers however will cut the e-mail in multiple parts.

The program will ask for some settings, if you decide to attach a PDF or HTML formatted play.

After that the send play dialog will open:

Recipients
Toi T esten@testing. ey E]
Cc: T estter?{@testing. e E]

I Subject: Bunting, Bunting carousel

Text: Practice your bunting

" Send ‘ﬁﬂanc&l‘ ‘ & Help ‘

The To and CC (Carbon Copy) fields can be filled with one or more e-mail addresses (separate the
e-mail addresses with a ;).

Pressing the more (...) button behind the TO or CC field will open the built-in e-mail address book.

The pre filled subject field can be altered and some additional information can be entered in the Text
area.

Connect to the Internet and press the send button.

If you are on dial-up, when done don't forget to disconnect.

e-mail address book

In the address book you can store e-mail addresses and define groups of addresses to sent mail to.

Only available if the internal e-mail client is used.
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2.11.1.1 select e-mail addresses

Select addresses

Select | Edit Groups

[7] = The first group
[] Another jes-soft, Second@jes-soft.com
¥l Tester Jes—soft, Tester @jes-soft.com

First name: Tester

Last name: Jes-soft

Add

E-mail: Tester @jes-soft.com
& OK ‘ﬁ {Zan{:el‘ ‘ & Help

You can select e-mail address or groups by checking the check boxes in front of them. Groups can be

recognized by the * in front of them.

On this tab an e-mail address can also be added, edited or deleted.

a7

To add an e-mail address, press the new button. After filling in the first name, last name and a valid
e-mail address press the add button for validation and if all is correct the e-mail address is added to

the list.

To edit an e-mail address, select an e-mail address from the list and alter the first name, last name or

the e-mail address. When the update button is pressed the address is validated and changed.

An e-mail address can be removed from the address book by selecting it from the list and pressing the

delete button.
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2.11.1.2 select edit mail groups

2.12

Select addresses

Edit Groups

[?The first group Ev[ Clear ][ Reset ][ Delete ]

| Another jes-soft, Second @jes-soft.com
| Tester Jes-soft, Tester @jes-soft.com

The first group Add Update

& OK ‘ﬁ Ean{:el‘ ‘ & Help

First select the e-mail group you want to edit.

Then select the e-mail address by checking the check boxes in front of them.

All address of a group can be removed by pressing the clear button.

This can be undone by pressing the reset button, which will bring up the previous selection.
A group can be removed by selecting it from the list and pressing the delete button.

To add a group, press the new button. After filling in name press the add button to add the new group
to the list.

To edit a group name over type the name at the bottom and press the update button.

Backup
There are two backup options.

1. Backup all the plays and drills by selecting Backup - Playbook.

3. Backup the plays and drills in the current play type (Plays, Drills, Formations, Templates or Other)
by selecting Backup-play type

2. Backup the plays and drills in the current category by selecting Backup - Category.
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2.12.1 Backup playbook

Backup progress -

baking regular backups is highly recommended.

& OK ‘ﬁ Eanc&l‘ ‘ &) Help ‘

There are two ways to backup the database.
1. To backup all the plays currently in the database go to the File menu and choose Backup playbook.

2. Every twenty-fifth time the program starts you will be asked to make a backup, which is highly
recommended.

To start a backup of your current plays press the OK button.
To skip a backup press the Cancel button.
Checking a check box can disable the automated backup question, this is not recommended.

After pressing Ok you can choose the file destination in a save file dialog.

Although backups seem to be time consuming, you would not be the first to have an accident, like a
power failure, resulting in a corrupted database and loss of work.

The steps on how to recover a database are described here.

2.12.2 Backup play type

Play type backup progress

This will backup all the plays/drills
of type Drill.
& OK ‘ﬁ Ean{:el‘ ‘ & Help ‘

To backup all the plays currently in the database go to the File menu and choose Backup play type
To start a backup of your current current category press the OK button.

To skip a backup press the Cancel button.

After pressing Ok you can choose the file destination in a save file dialog.

The steps on how to load a backup file into a playbook database are described here.
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2.12.3 Backup category

Category backup proga

This will backup all the playsidrills inthe
Infield/baserunning categary of type Drill.

& 0K ‘ﬁ Ean{:el‘ ‘ &) Help ‘

To backup all the plays currently in the database go to the File menu and choose Backup category.

To start a backup of your current category press the OK button.
To skip a backup press the Cancel button.
After pressing Ok you can choose the file destination in a save file dialog.

The steps on how to load a backup file into a playbook database are described here.

2.13 Option menu
To set defaults go to the Options menu...
The following sections are available in the options window.

View, options for the view tab.

Sketch, set default values for sketch editing.

Text, select a default font for text and sketch text.

Plan, set defaults for the plan tab.

E-Mail , for activating the internal send mail option.

Export, select how images headers will look when exporting them.
Appearance, change the program style template.

Miscellaneous, some additional settings.

Resources, information about the program.
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2.13.1 View tab options

»  View tab options

Show all sequences including animation anby

Usefilteron field

Only one option on this tab.

Only two options on this tab.

When the first is checked all sequences of the play are shown in the overview tab, otherwise the
sequences made to make the animation smoother (with the animation only checkbox checked) are
hidden.

If the filter is applied, the fields on the view tab will appear smoother, use only on a fast computer.
Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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2.13.2 Sketch tab options

" Sketch tab and field options

Try moving playersto their new positionwhen adding a newlast sequence
Lse undo history list

&1 Flip/mirror all sequences of a play

Keep line buttons down

Default field colors

Plugins

Options - Sketch

If the option "Try moving players to new position when adding a sequence"” is checked the program will
try to move players and pucks to their next position, when a new last sequence is added.

Checking the option "Use undo history list", will make the undo, redo history available on the edit
drawing tab, if this option is not selected the undo function will "remember" only the last action.

If the "Keep line buttons down" option is checked, a line drawing button will stay down after completing
a line, this might speed up the drawing of a sketch.

With Flip/Mirror all sequences of play checked, the whole play will be flipped or mirrored instead of just
the current sequence, when flipping or mirroring in the edit drawing tab.

For the default field colors press the Change button.

When a plugin is available you can select and/or activate the plugin.
Pressing the OK button will store the changes and bring you back to the main window.
Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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2.13.2.1 Change default field colors

-
Edit default fizld colors

o —

Ot field

-‘ tare Colors. . ‘

AN TEE
ENEEE
EENEEN |
ENEEEE
ENNNEN
ENEEEE

& OK |3Canc&l“ Default H Reset H &) Help ‘

In this window the default colors of the field can be adjusted.

By clicking on the field the two different areas (border, ice) of the field can be selected

You can alter the default color by selecting a color from the quick color select area or by pressing the
more colors button to open a color dialog.

Pressing the OK button will store the new colors and bring you back to the main window.

The Cancel button will reset the colors to their previous values and bring you back to the main window.
The Default button will load the default values for the colors for both the field and the players.

The Reset button will reset the colors to their previous values.

Colors only appear when the field is not in black and white.
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2.13.2.2 Plugin

- —

Activate plugin R —
Select plugin Court preview
Jesningette - 2 -
Description I

Ringette - 2 iz a plugin for Hockey playboaok 0.8, .

[t congists of 10 different courts. U
5 black & white courtz and the zame zet in
color.

The courtz are avallable in 100 % and 200 %
size.

|| > 2

l & OK J|ﬁ£an{:elH @Help‘

If a plugin is available you can click the Plugin option on the sketch tab of the options dialog.
In the plugin window you can select and preview the available plugins.
A plugin can be selected from the list.

When selected a short description about the plugin is available and the plugin fields can be viewed on
the right.

Selecting Active : Yes will activate plugin, to deactivate select No.

More information about plugins might be available at www.jes-soft.com.
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2.13.3 Text tab options

-

Playbook options
View Font: Arial
Size: -
Sketch - 10
Style: B I U
Text —
Color: | NN
Flan
Sample
E-mail
Export AaBbYyZiz
Appearance
Miscellaneous
Resaources
| & OK | ‘ Apply ‘ ‘%Eanc&l‘ & Help

Options - Text

The default font for both the text and the sketch text can be adjusted, by selecting the font name, size

and style.

Additional font colors are available by pressing the More... button.

The sample area will show a preview of the new default font.

Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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2.13.4 Plan tab options

i . - Ny
Playbook options
e S —
View ¥ Load last plan list on start up
¥ Owverwrite play info when loading a complete plan list
Sketch
Text
Plan
E-mail
Export
Appearance

Miscellaneous

Resources

| & OK | ‘ Apply ‘ ‘%Eanc&l‘ & Help

. — = e — —

Options - Plan

When checked the plan list will not be automatically reloaded on start of the program. This will result in
a blank plan list when the program is started.

If a complete plan list is loaded from an external file the drill time of each play in the file will be used
and overwrite the drill time in the database if the overwrite play info option is checked.

Pressing the OK button will store the changes and bring you back to the main window.
Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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2.13.5 E-mail
i«
Playbock options

Lz The information below is needed before you can use the smtp
send mail function. If you do not know the information

Sketch requested, please contact your system administrator or Internet

e ¥ Use internal e-rnail client

Plan "r'u?uur narne:
First Last

E-mail Your e-mail address:

yourname@testing.com
Export Outgoing mail (SMTP] server

smtp.testing.com

Appearance
Miscellaneous

Resources

| & OK | ‘ Apply ‘ ‘%Eanc&l‘ & Help

. e = e — —

Options - E-Mall
You can choose to use the internal e-mail client by checking the Use internal mail client checkbox.
Before the internal mail client is activated, your mail identity must be correctly filled in.

The name field should be filled with your name or the name of your organization.
The e-mail field should contain a valid e-mail address, for example yourname@yourprovider.not.

The outgoing mail (SMTP) server should contain the smtp address of your provider for example
smtp.yourprovider.not; the combination of e-mail address and smtp address is often checked for
validation.

If your (SMTP) server requires authentication or uses a different port then go to the SMTP Server
Settings by pressing the More button.

If you are on a network connection, there might be a network mail/proxy server, in that case provide
the address of this server.

Note that this is basically the same information you would provide in the Internet settings for outlook.
Pressing the OK button will store the changes and bring you back to the main window.
Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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2.13.5.1 SMTP Server Settings

SMTP server settings

o My outgoing server (SMTP) regquires authentication
Legon using

User Mame: yourname@testing.com

¥ Use TLS (install openssl)

Port: 587 (Default = 25)

‘ o OK Hﬁﬂanc&l‘ | ﬁﬂelp|

Options - E-mail - More

Some times a SMTP server requires authentication, you can check the checkbox if you need this
option.

If checked you can fill in your smtp server user name, you will be asked for your password when
actually sending an e-mail.

If you want to use Transport Layer Security (TLS), you first have to install it, with for example
OpenSSL.

You can read about OpenSSL on their homepage at http://www.openssl.org.

A windows installer can be found at Shining Light Productions, as the playbook program is 32bit the
Win32 light version should be used.

If you like this product please support them. Don't forget that OpenSSL is subject to local and state
laws. More information can be found in the legal agreement of the installation.

Some providers also use a different port, just fill in the different port number to change this.
Pressing the OK button will store the changes and bring you back to the Mail identity window.

The Cancel button will bring you back to the main window, no changes will be made.


http://www.openssl.org
http://slproweb.com/products/Win32OpenSSL.html
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2.13.6 Export settings

Playbook options

Marne: Logo

Flan

E-mail Image file format for export

Export @ PNG PG

Appearance ¥ Try using anti-alias on copy image

Miscellaneous

Resources

| & OK H Apply Hﬁﬂanc&l‘

Options - Export

The following options can be set here.

Logo
You can change the logo used in the header when exporting to PDF, html format or printing by clicking

the browse button and selecting a new images. The image will be resized by the program to fit, images
with a width of 260 and a height of 180 pixels work fine (13:9).
By clicking the Default button the logo will be reset to the default logo

Image file format for export

You can choose between the PNG and JPG file format.

PNG is a loss less file format, and works very well for diagrams. However some mail clients don't
support it.

JPEG is a lossy file format, and more suited for photographs, which means the quality of a diagram will
not be perfect.

For playbook sketches the file size of a PNG file is up to ten times smaller than a JPEG file of the
same sketch.

If the "Try using anti-alias on copy image" option is checked the program will try to apply an anti-alias
filter on the image, when copying an image to the clipboard (CTRL+I) or (SHIFT+CTRL+I).

Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.
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The Cancel button will bring you back to the main window, no changes will be made.

2.13.7 Appearance

i .

Playbook options .

Wiew Program style: Windows 7 b

Sketch

Text

Flan

E-mail

Export

Appearance

Miscellaneous

Resources

(700 L | e

b e — = P ———— —_— =

Options - Appearance

Change the program style by choosing one of the many option, some you will like others are just awful.
Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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2.13.8 Miscellaneous

-

Miscellaneous

Resources

| & OK H Apply H%Eanc&l‘

Playbook options .
LLEL Select database: Default T
Sketch
’;ﬂ Add database Delete database
Text
Plan
Delete tag from all plays:
E-mail Mo tag filter - Delete tag
Export
Appearance

. —

Options - Miscellaneous

For power users only, you can create an extra database for your plays and drills, for example we store

each year in a different database.

You could also just tag plays with a year, but if at a later state you decide to remove the tag you can do
it here, the delete tag options are only visible when you have used tags in your current database.

Pressing the OK button will store the changes and bring you back to the main window.

Pressing the Apply button will store your changes.

The Cancel button will bring you back to the main window, no changes will be made.
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2.13.9 Resources

2.14

 Baseball Playbook 011

gﬂldditinnal plays and drills can be found at:
http:/fwww jes-soft.com/baseball/downplay.html

About baseball playbook 011
Jes-soft, copyright: 1998 - 2014

Visitthe baseball playbook site
http://www.jes-soft.comfbaseballfindschtml

Resources

Options - Resources

A quick link to some resources about baseball playbook 011.

For additional plays and drills go to the download play page by pressing the Go... button
Pressing the About button will give some more info about the program.

Finally there is a link to the index page of the baseball playbook program.

Exit program

To exit the Baseball Playbook program go to the File menu and choose Close Playbook or click on the
X in the upper right corner of the window.

Before exiting the program all modifications to the plays and drills are stored in the database.
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3.1

3.2

3.3

Miscellaneous

Undo

To undo an action press the undo button or press CTRL-Z.

Undo is available for drawing and text editing.
Redo

To Redo an action previously undone press the redo button or CTRL-Y.

Redo is available for sketch and text editing; the option Use undo history list on the sketch tab of the
options dialog should be selected.

Copy, cut and paste

To use copy, cut or paste go to the edit menu and choose the corresponding option.

Copy sketch
When copy sketch is clicked the current play sketch is copied to the clipboard. The image can then be

paste/imported in almost all word processors and graphics programs.
Holding down shift when copying an image will result in a double sized copy of the current sketch.
The appearance of the images can be changed on the export tab of the options menu option.

Copy text
When copy text is clicked the selected text to the clipboard. The text can then be paste/imported into

the baseball playbook or other applications.
Copy text is available in the overview tab and the edit text tab.

Cut

When cut is clicked the selected text is moved to the clipboard. The text can then be paste into the
baseball playbook or other applications.

Cut is only available for text editing.

Paste

When paste is clicked the text, if available, is moved from the clipboard to the cursor position in the
text screen.

Paste is only available for text editing.

Select all
In text editing when select all is clicked all the text will be selected.

When editing a sketch all players will be selected.

Select all is only available for text and drawing editing.
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3.4

3.5

Trial period

-

Trial period

Baseball Playbook 011

‘fou are in day 1 of your trial period.
After 30 days some of the functions like:
multiple select,

play list functions and

curved lines

will be disabled.

Information about registering this product can be found at:
btk A v, jez-zoft comdbazeball/reqizter ktml

« OK | Register H & Help ‘

e

After a 30-day trial period some functions of the playbook program will only be available for registered
users.

The registered version of Baseball Playbook has the following extras:
Creation and export of plan lists.

Export to animation in flash format.

Snap to grid when drawing a sketch.

Export of a drill in PDF file format.

Sending a play with e-mail.

Changing of the line color and line thickness.

Add text to a play sketch.

Use of different colors with polygons and ellipses.

Export of play sketches in PNG file format.

Curved movement lines.

Dragging of line points.

Undo and redo on the edit drawing tab.

Auto placement of players when adding a new last sequence.
And more....

After the trial period you can prevent this message from popping up by checking a check box.

More information on registering this product can be found at:
www.jes-soft.com

Adobe Acrobat Reader

PDF files can be opened with the free Adobe Acrobat Reader.
If you are experiencing problems opening PDF files, please download the latest free version of Adobe
Acrobat Reader.

Get Adobe Acrobat Reader



http://www.jes-soft.com/baseball/register011.html
http://www.adobe.com/prodindex/acrobat/readstep.html
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3.6

3.7

3.8

3.9

Baseball playbook homepage

On the Baseball Playbook Homepage you will find the following information:
1.Updates of the program.

2.Additional plays and drills in zip format.

3.Links for downloading new versions.

4.Reviews of the playbook program.

The homepage address is http://www.jes-soft.com/baseball/

You can submit your plays as an attachment in *.EBP format to baseball@jes-soft.com, received plays
will become part of the database and might be published on the website.

Drag and drop

Dragging and dropping of a player is done by selecting a player with the left mouse button.

While keeping the left mouse button down the player can be moved to its (new) position.

When the mouse button is released and the player is above the field the player is dropped on the field.
Drawing lines

Lines can be drawn by pushing one of the movement buttons.

If a movement button is pressed you can click with the left mouse button on the field, this will start the
movement line.

Additional parts of the line can be added by clicking with the left mouse button on the field.

Clicking with the right mouse button will end the line.

See the symbols for an explanation of the different lines.

E-mail attachments

With Thunderbird:

To attach a file to an outgoing email message:

1.In the message composition window, click and hold Attach (the paperclip) and then choose File.

2.Select the file you want to attach and click Open.

The file appears in the attachments list.

With Outlook Express:

In the new message window. To insert a file, click the Insert menu, click File Attachment, and then
double-click the file you want to send.

Additional plays can be found at the Baseball Playbook Homepage.



http://www.jes-soft.com/baseball
http://www.jes-soft.com/baseball/
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3.10

3.11

3.12

3.13

Gif file format

The Gif file format uses a maximum of 256 colors and a very strong compression algorithm which
keeps the files small.

The Gif component in the playbook software is based, in part, on the work of Anders Melander.
Load backup file

To restore or load the plays in a Baseball Playbook Backup file (PLAYS.BAK, ALLPLAYS.BAK) go to
the File menu and choose Open.

Change the file filter (Files of type:) to Baseball Playbook Backup (*.bak) select the file you want to
open and press Open.

If a play in the backup file is already in the database the New play name window is shown. This allows
you to:

1.Alter the play name.

2.Skip the current play, but load the next.

3.Skip all plays in the database, but load all the others.

4.Replace the current play.

5.Replace all plays in the database.

6.Cancel the loading of the rest of the file.

This function can also be used to load the files with plays located at the Baseball Playbook Homepage.

Logo

7

The above logo is the default logo shown in the upper left corner of each printed page, exported play
or category or list.

Instead of this logo you can use your own default logo by replacing the file logo.bmp in the installation
folder of Baseball Playbook.

The logo.bmp file should be in windows .BMP format with a width of 260, a height of 180 pixels and a
color depth of 256 colors.

Selecting players

When none of the movement buttons is selected, you can select a player or a line by clicking it in the
field window.

To select multiple players and lines, lines hold down the CTRL button while clicking on the
players/lines.

You can also select an area of the field by holding down the shift key and using the main mouse button
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3.14

to resize a selection rectangle.

Finally all players/lines can be selected by choosing Edit - Select All or by pressing CTRL-A.

A selected player or line will have big dots, showing it has been selected.

Players or lines that are selected can be deleted by pressing the Delete button on the Edit drawing tab.

Selected players or lines can be unselected by clicking them again with the left mouse button.

Shortcut keys

An overview of the shortcut keys available.

General

Shortcut keys

Action

Remarks

F1

Show context sensitive help

Every dialog/windows should
have its own help topic

TAB/SHIFT TAB

\Walk through the items on the
screen

Down, Home

Arrow keys, END, Page Up, Page|Might change a control

View tab

Shortcut keys

Action

Remarks

CTRL+O Open play or backup file You might have to change the file
filter.

CTRL+P Open the print dialog

CTRL+C Copy all text to clipboard

CTRL+I Copy sketch to clipboard Check Options-Export to set anti-

alias

CTRL+SHIFT+I

Copy double size sketch to
clipboard

Check Options-Export to set anti-
alias

CTRL+L

IAdd current play to plan list

Sketch tab

Shortcut keys

Action

Remarks

CTRL+O Open play or backup file You might have to change the file
filter.

CTRL+P Open the print dialog

CTRL+I Copy sketch to clipboard Check Options-Export to set anti-

alias

CTRL+SHIFT+I

Copy double size sketch to
clipboard

Check Options-Export to set anti-
alias

CTRL+A Select all items on the sketch
CTRL+Z {Undo
CTRL+Y [Redo If use undo history list is checked
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CTRL+ALT+Z

Open Redo/Undo History list

If use undo history list is checked

CTRL+mouse

\When selecting items and
holding down the CTRL key you
can add or remove items from
the selection

SHIFT+mouse

\While holding the SHIFT button
down, a dashed rectangle is
drawn on the sketch all items
within the rectangle will be
selected

CTRL+SHIFT+mouse

\While holding the CTRL+SHIFT

buttons down, a dashed

rectangle is drawn on the sketch

all items within the rectangle will
be added to the selection

DELETE ||De|ete the selected item(s)

Arrow keys INudge selected items(s) If you want to move the selected
items over a greater distance use
the mouse

CTRL+L IAdd current play to plan list

Text tab

Shortcut keys

Action

Remarks

CTRL+O Open play or backup file You might have to change the file
filter.

CTRL+P Open the print dialog

CTRL+C Copy selected text to clipboard

CTRL+Z Undo

CTRL+X Cut selected text to clipboard

CTRL+C Copy selected text to clipboard

CTRL+V Paste text on the clipboard on

cursor position or replace
selected text

CTRL+B Toggle bold font on/off

CTRL+I Toggle italic font on/off

CTRL+U Toggle underlined font on/off

CTRL+L Left align paragraph

CTRL+E Center paragraph

CTRL+R [Right align paragraph

CTRL+1 Place @ at cursor position Wingdings 2 font needs to be
installed

CTRL+2 Place @ at cursor position Wingdings 2 font needs to be
installed

CTRL+3 Place ® at cursor position Wingdings 2 font needs to be
installed

CTRL+4 Place @ at cursor position Wingdings 2 font needs to be
installed

CTRL+5 Place ® at cursor position Wingdings 2 font needs to be

finstalled
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CTRL+6 Place ® at cursor position Wingdings 2 font needs to be
installed

CTRL+7 ||Place ® at cursor position Wingdings 2 font needs to be
installed

CTRL+8 Place ® at cursor position Wingdings 2 font needs to be
installed

CTRL+9 ||Place ® at cursor position Wingdings 2 font needs to be
installed

CTRL+0 [Place ® at cursor position Wingdings 2 font needs to be
installed
II

Plan tab

Shortcut keys Action Remarks

CTRL+O Open plan list or complete plan [You might have to change the file

list file filter.
CTRL+P Open the plan list print dialog
CTRL+L IAdd current play to plan list

3.15 Text edit buttons

Cut the selected text and place the text in the clipboard
Copy the selected text and place the text in the clipboard
Paste the text in the clipboard at the current cursor position
Undo the last action

Redo the last action

Make the selected text bold, or start bold text

Make the selected text italic, or start italic text

e ~ ®w 2 ¥

Underline the selected text, or start underlined text

Place a bullet in front of the selected paragraph(s) or start a bullet list

Align the text left
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Center the text

Align the text right

3.16 The symbols

@
Ay X
aye

C

LG

Offense

Defense

Wheelchair

Coach

Ball

Ball rack

Pylon

Base

Throwing line, direction of the ball

Direction of the player

Movement of player with ball

Hit

Ellipse

Polygon
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Text
3.17 Zip and unzip

Here are some points about Zip.

A *.ZIP file is a file which contains one or more compressed files. Compression is very useful in
keeping download times low.

This format is standard in windows XP but for older computers you will need a zip program.
To decompress/unzip a zip file you will need a Zip/Unzip program. Zip programs can be found on the

Internet, | found several using the following links:
www.tucows.com

www.zdnet.com

Sometimes when unzipping a file you will get an error like: This file is corrupted.
Usually this means that you have not downloaded the complete zip file.
Downloading it again will often solve the problem.


http://www.tucows.com/
http://www.zdnet.com/
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4.1

4.2

4.3

Frequently Asked Questions

How do | complete the registration process ?

After installing the software, which can be downloaded from one of the links at:
http://www.jes-soft.com/baseball/download.html

Please follow the steps below:

1.Start the program, Click Start, All Programs, Baseball Playbook 011 and click Baseball Playbook 011
2.Locate and click on the register menu option (next to the help).

3.Fill in your registration code you received by e-mail and click Ok

4. After registration the register option has disappeared.

How do | download and open additional plays and drills ?

First go the download play page at:
http://www.jes-soft.com/baseball/downplay.html

Click on the set of plays you like to download, when asked to open or save choose save and save the
file (remember where you put it). Sometimes you have to right click on the link to be able to save the
zip file.

---- You might skip the part if you are using win Xp
As the plays are placed in a zip file you will need an unzip program, which you can find at
http://www.tucows.com or

http://www.winzip.com

Some zip programs are free others are shareware.
Start your unzip program and open the file with plays you just downloaded.

Extract the plays (*.ebp or *.bak file) to a (temporary) folder/directory, remember the place.

Start the playbook program.

For the *.ebp files use the File-Open function.

For the *.bak files use the File-Open function and change the file type to Baseball Playbook Backup
(*.bak) or to *.* to see the file you like to open.

After that follow the instructions on screen or press F1 for additional help.
How do | submit a play ?

The following is a list of steps describing sending plays to other playbook users via E-mail, while not
using the built in e-mail functions:

Locate the play you want to sent and choose File - Save, this will save the play in *.EBP format
Write down in which folder/map and under which name you saved the play

Start your E-mail program

Fill in the e-mail address, and any comments you might like to sent with the play

To attach the play click on the paper clip or attach option

Browse through your files and folders until you have found the file to attach

Select the file and press Ok

Connect to the internet

Press the sent Button
Note: if you submit multiple files you might want to zip them first, this will decrease the file size by 80%.


http://www.jes-soft.com/baseball/download.html
http://www.jes-soft.com/baseball/downplay.html
http://www.tucows.com
http://www.winzip.com
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4.4

4.5

Players/lines that are placed on a field will not go onto the field
where | want them.

Check if the Snap checkbox on the edit drawing tab is unchecked.
If it is not unchecked please remove the check mark and try again.

When the snap function is checked, an invisible grid is used to align players and lines. The size of the
grid can be altered by changing the value behind the check box. It really helps if you want to draw
straight lines, circles, squares or align text.

Error on loading Winsock? library (WS2_32.DLL)...

Our last windows 95 machine broke down so for this version we haven't got a clue if it still works.
For those that want to try running this program under windows 95 (not supported).

This version of Baseball Playbook needs the Winsock? library.

However this library is not standard with windows 95.

You can download the Winsock? library from the following page:
Windows Socket 2 Update



http://support.microsoft.com/kb/182108/EN-US/
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